Example name Tamiflu Hospitalized

Effect size Risk ratio
Analysis type Basic
Level Basic
Synopsis

The US government has spent 1.4 billion dollars to stockpile Tamiflu, in anticipation of a possible flu
pandemic. Cochrane recently published a 500+ page report that evaluates Tamiflu’s utility in a wide
number of areas. Tamiflu was shown to be effective for some outcomes but not for others. This analysis
that follows is taken from that report, and focuses on Tamiflu’s ability to reduce the risk of
hospitalization.

This analysis includes seven studies where patients were randomized to receive either Tamiflu or
placebo. Outcome was the proportion of patients hospitalized in each group. The effect size is the risk
ratio.

We use this example to show

e How to enter data from 2x2 tables

e How to perform a simple analysis

e How to interpret statistics for effect size

e How to interpret statistics for heterogeneity
e How to create a high-resolution plot

To open a CMA file > Download and Save file | Start CMA | Open file from within CMA

Download CMA file for computers that use a period to indicate decimals
Download CMA file for computers that use a comma to indicate decimals

Download this PDF
Download data in Excel
Download trial of CMA
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http://www.meta-analysis.com/downloads/Tamiflu%20Hospitalized%20P.cma
http://www.meta-analysis.com/downloads/Tamiflu%20Hospitalized%20C.cma
http://www.meta-analysis.com/downloads/Tamiflu%20Hospitalized.pdf
http://www.meta-analysis.com/downloads/Tamiflu%20Hospitalized.xls
http://www.meta-analysis.com/

Start the program

E Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Teols Cemputational options Analyses Help

Rinanayses » % 0 @@ H| &) & | 2@ & Mwme -2+ 8 ii|®|

A B ‘ C ‘ D ‘ E G ‘ H ‘ | ‘ J ‘ K. ‘ L ‘ I ‘ M ‘ o ‘
1 5 Welcome ==
2
-]
4 ‘Wwhat would you like to do?
5
.8
7
g " Run the tutarial
9 " Start a blank spreadsheet
% © Start a new spreadsheet using a template
12 ' Open an existing file
% " Import data from another program
| 15]
| 16| = Morefiles ... i
17 L
% B C:hlzers\MichashDropbosiwork shops 245 epsishSepsis.cma
20 B C:hlzers\MichashDropbosiwork shops 245tating on markality by sn
21 B CMUserstMichaehDiophosiiwiorkshops 24w sight LossWweght Los
22 B CMUserstMichaehDiophosiiwiorkshops 24Prehospital thrombolysiz*
| 23] B CMUserstMichaehDiophosiwiorkshops 24Percutaneusidaterial pr
i; B CMUserstMichaehDiophosiiwiorkshops 24Steroid in bypazshSteni
E B CMUserstMichashDiophosiiwiorkshops 24Carotid stent and mortall =
27
28 L
29 [ Show this dislog when | start the program
| 30 Close | ok |
A
32
| 33 —
| 34
35
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e Select the option [Start a blank spreadsheet]

e Click [OK]

E‘ Comprehensive meta analysis - [Data]

Eile Edit Format View [nsert Identify Tools Computational options Analyses Help

Rnanayses + % D Z[HH & 4 | =@ &
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5. Welcome =l

What would you like to do?

B bt aial

" Open an existing fle

" Import data from anather program

¥ Show this dialog when | start the program

Elose
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The screen should look like this

E‘ Comprehensive meta analysis - [Data]

Eile Edit Format View Insert Identify Tools Computational opticns Analyses Help

Runanatyses + % N o5 FH | S| & [ BB @ =SS @8 -V >+ v 4 3D
A B [ o] E F G H | J K

I I

|

-

|4

|5

&

7]

8

o

10

1]

12

|13

14
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Click Insert > Column for > Study names

E Comprehensive meta analysis - [Data]

File Edit Format VNiew | Insert Identify Tools Computational options Analyses Help
Run nayses > % [ Mm o+ E D
2 Subgroups within study
A B plenk column Comparison names H ! d K L M N
[ia Copy of selected column
A I Outcome names
2 *— Blank row ) -
— Time point names
3 *= Blank rows
- Copy of selected row(s) %8 Effect size data
|5 — Moderator variable
6 Y= Study r
7
|8
-

The screen should look like this

E‘ Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Computational options Analyses Help
Rup gnayses LI N R an o)
Study name B ‘ C ‘ D ‘ E ‘ F G H ‘ | ‘ J ‘ K ‘ L | 5} ‘ M
-
| 2|
|3
|4
5
L
7
8
|3

Click Insert > Column for > Effect size data

E‘ Comprehensive meta analysis - [Data]

File Edit Format Eiew|1nsert Identify Tools Computational options Analyses Help

[rnrores 5 00 i Y sy o oo+ vl @)

'I Blank column Subgroups within study

Study name . H ‘ | ‘ J ‘ K ‘ L ‘ ] ‘ M ‘
Comparison names

Copy of selected column

1 Outcome names
2 *— Blank row . .
— Time point names
3 *= Blank rows
|4 Copy of selected row(s) & m
| 5| — Moderator variable
3 Y= Study T
7
8
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The program displays this wizard

Select [Show all 100 formats]
Click [Next]

Select [Comparison of two groups...]
Click [Next]

Drill down to
Dichotomous (number of events)

Unmatched groups, prospective ...
Events and sample size in each group

© www.Meta-Analysis.com

-

B Insert columns for effect size data

Welcome

" Show commaon formats only
@ Show all 100 formats

-
By Insert columns for effect size data

If you have alieady computed the effect size [such as the
standardized mean difference or the Log odds ratio] for
each study, you may enter this information directly.

Or, vou may provide summany data (such az the number of
events of the means and standard deviations), and the
program will compute the effect size autamatically

Use thiz wizard ta specify the type of data you plan to
enter, and the program will create the required colurnns.

The program allows you to enter effect size data in maore
than one format. You will create one set of effect size
columns now, and may add additional sets at any time:

Types of studies included

options ta be displayed on the nest panel

change the selection.

Comparizon of two groups, time-points,
of exposures fincludes corelations)

in one group &t one time-poink

o
r E stimate of means, proportions or rates
" Generic point estimates

&

Generic paint estimates, log scale

B9 Insert columns for effect size data

On this panel, select the lpe of studies to be included in
thiz meta analyziz. This controls the types of data entiy

[ unsure, select the first option, which is appropriate for
most analyzes. You will be able to return to this panel and

Click on the icons to select the data entry format

Q Two groups or carrelation
E@ Dichotomaus [number of events)
m Unmatched groups, prospective (e.q., controlled trials, cohart studies)
W Events and sample size in each gioup |
|£] Mon-events and sample size in each group
@ Eventz and non-events in each group
@ Event rate and sample size in each group
@ Chi-squared and tatal sample size
Q Matched groups, prospective (e.q., crossowver bials or pre-post designs)
@ Unrnatched graups, retrospective [2.9.. case control studies]
Q Computed effect sizes
@ Continuous [meansz]
@ Canelation
@ Rates [events by person years]
@ Survival [time to event)

Tamiflu hospitalized
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The program displays this wizard

Enter the following labels into the wizard

e  First group > Tamiflu

e Second group > Placebo

o Name for events > Hospitalized

e Name for non-events >

Ok

Click [Ok] and the program will copy the names into the grid

@ Comprehensive meta analysis - [Data]

File Edit Format Wiew Insert Identify Teols Computational options Analyses Help
Run analyses — %o P = =Cm oo =% H - 2+ ‘/D %¢ §¢ @
Study name HoL;irtl?alfl!lz’Ied ;g{g;”ﬁ HESI‘;\EEEE;d E'[Igtcjb Odds ratio Luﬁaﬁgds Std Err Wariance J K L ] M
1
2
3
4
5
[
7
8
g [ Group names = | B |
10
11 Group names for cohort or prospective studies
}g Marne for first group [e.g.. Treated) Tamiflu
14 Mame for second group [e.q., Control) dF‘Iacebo
15
16
17 Binary outcome in cohort or prospecti tudi
:g Mame for events [e.g.. Dead] Haozpitalized
20 Mame for non-events [e.q., Alive]
21
22
23 Cancel
24
25
26
27
20
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There are three options at this point

e Enter the data directly into CMA
e —or-Open the CMA data file
e —or— Copy the data from Excel

Here, we’ll show how to copy the data from Excel
e Switch to Excel and open the file “Tamiflu Hospitalized.xIs”

e Highlight the rows and columns as shown (Columns A to E only), and press CTRL-C to copy to
clipboard

H - = Tamiflu Hospitalized.xlsx - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
Al - I Study
A B C D E F G H 1
1 |Study Tamiflu E Tamiflu N Placebo E Placebo N
2 |M 76001 9 965 4 482
3 |WV15670 1 484 2 235
4 |WV15671 6 411 1 201
5 |Wwv15707 2 17 1 9
6 |Ww15812/872 9 159 9 202
7 |WV15819/876/978 9 362 11 373
8 |W\V16277 2 225 4 226
2]

-
=]
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e Switch to CMA

e Click in cell Study-name 1
e Press [CTRL-V] to paste the data Click here

e The screen should look like this

@ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools mputational options  Analyses Help
Run analyses =+ % [ = =] & =3 &= E R H 2+ D %l %i @
Study name )M%Eg ;g{;:fﬁ HnPsl‘;ﬁ:\kljzoed FT“E::\?‘JD Odds ratia Lorgaﬁndds Std Err Variance J
1] Shudy Z T amiflu E Tamiflu M Placebo E Placebo M
2| M 7E0m 3 965 4 452 1125 0118 0.604 03654
3| w5670 1 454 2 235 024 -1.422 1.227 1.508
4| w5671 [ 411 1 20 2963 1.086 1.084 1174
5| w5707 2 17 1 9 1.067 0.065 130 1.692
B| wA'15812/872 3 193 3 202 1.016 0018 0.482 0233
7| wA'15819/876/978 3 362 1 373 0833 0175 0.456 0.208
8 wWATE27T 2 225 4 226 0438 -0.693 0.871 0759
g
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At this point we should check that the data has been copied correctly

@ Comprehensive meta analysis - [Data]

File Edit Format Wiew Insert Identify Teols Computational options Analyses Help

Runanayses + % DIz (H W | &) % B @ E '—'="S| 8 %

B2+ 8 R @

Tamiflu Tamiflu Placebo Placebo .| Logodds .
Study name Hospitalized Total N Haspitalized Total M Odds ratio ratio StdErr Wariance J S L N

1| Study Tamifl E TamifluM  Placebo E Flacebo M |

2| M 7EO001 3 955 4 482 1128 0118 0.604 0.354

3| 15670 1 484 2 23 0.241 1422 1.227 1.506

4| 15671 [ 411 1 2m 2.963 1.086 1.084 1.174

5 Wwh15707 2 17 1 | 1.067 0.065 1.30 1.632

B| w1581 2/872 3 199 3 202 1.016 0oie 0.482 0.233

7| 'wh15819/876/978 3 362 1 373 0.839 0175 0.456 0.208

8| Wwh1B277 2 225 4 226 0.458 -0.638 0.871 0.753

|
10

e C(Click anywhere in Row 1
e Select Edit > Delete row, and confirm Click here
@ Comprehensive meta analysis - [Data]
File | Edit Format View Insert Identify Tools Computational options Analyses Help
Run: = Bockmark data =1 B A== :8 =2+ |:| 2l % @
Tamiflu Flacebo Placebo q Log odds .
Columnn properties Tatal M Hospitalized Tatal M fddelali ratio Sl R d % L M

1 e R Tamiflu M Placebo E Placebo M

3|52 Cepyestalom @k a5 s 2 1128|018 oemM 034

3 Copy with header 434 2 235 0.241 1422 1.227 1.506

4 Copy entire grid 41 1 20m 2963 1.086 1.084 1.174

5 17 1 9 1.067 0.065 130 1.652

gl @ Poste Hrisy 199 3 2| 1o18|  0ot6 0482 028

7% cut Chrl+X 362 11 373 0833 0175 0.456 0.208

g 7 Delete Del 225 4 226 0433 -0.693 0.871 0.753

10

11 Delete study

12 Delete column

13

14 Edit group names
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By default, the program is displaying the odds ratio as the effect size

We want to switch to the risk ratio

E‘ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options

Analyses Help

ﬂ Customize computed effect size display

e Right-click on any of the yellow columns
e C(Click Customize computed effect size display

E‘ Comprehensive meta analysis - [Data]

Rnanayses + 2 O B H| &) ¢ @& —="E8 a9 -V >+ v 4 §l|®|
Tamiflu Tamiflu Flacebo Placebo 5 Log odds .
Study name Hospitalized ‘ Total N Hospitalized Total M Odds ratio ratio StdEr ‘ Variance ] ‘ K ‘ L ‘ M ‘ N ‘ o
1 M 7600 9 965 4 482 0118 0.604 0364
2| w1870 1 484 2 238 0 4| sota-z
3| w1867 E 411 1 2m 2 2| stz A
4/WA1E707 2 17 1 9 | B T
5| WwAi15812/872 9 199 9 202 1 Column properties
B| \/15819/876/978 9 382 1 373 0 -
7| wi1e277 2 225 4 2% g DEE@EETEmt
8 2. Formulas
9
0l Show all selected indices
11 ﬂ Show only the primary index
% “3 Set primary index to Odds ratio
| 14
| 15|

File Edit Format View Insert Identify Tools Computational options Analyses Help

Runanarysu—b%\Dﬁu|§|¥;‘ﬁ|g§ O.g'.'o'g'ﬁ'r_)""/l:”%liwq)‘
T amiflLy T amiflu Flacebo Flacebo 5 Log gdds | | | | | |
Study narme Hospitalized ‘ Total M | Hospitalized Total M Ddds ratio Ea [ Effect size indices l = | = Ig‘ & ‘ by ‘ o
1 M 00 | 965 4 482
| 2W15E70 1 404 2 235 024 Usze the following az the primary index
| 3WAIEET E 411 1 2m 2.963
|4 wNIETOT 2 17 1 3 1.067 | Fisk ratio =]
| 5WAIERI2/872 | 189 9 202 1.016
| B Wwh1B819/876/978 ] 3E2 1 373 0.829 Display columns for these indices
T WAIBZTT 2 225 4 226 0.498
g [ Oddsratio -
) [ Log odds ratia
10 [J  Peto odds ratio
ER [0 LogPeto odds ratio
BE Risk. ratio
BE Lag risk ratia
BT [ Risk difference
el [ Std diff in means
L 15 [0 Hedges'sg
| 151 [ Difference in means
| 17 [ Std Paired Difference
| 18 [ Corelation
| 13 [ Fisher'sZ
| [0 Rateratio
LA ] Lograte ratio
| 22| [ Rate difference
23 ] Hazard ratio -
| 24 [V Also show standard error
% ¥ Also show vaiiance
| 27 " Show the primary indes only
% @ Show al selected indices
E
] ——
32 Cancel
E
34 —
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e Tick Risk ratio

e Tick Log risk ratio

e Select Risk Ratio in the drop-down box in the wizard
e De-select Odds ratio

e De-select log odds ratio

e C(lick Ok

The program now display the risk ratio rather than the odds ratio

@ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options Analyses Help
Aunanayses + %2 D @ (| S| $ BB | E"-"="Z|B WS -4 2+ V[ 143D
T arniflu T amniflu Flacebo Placebo . Log risk .
Study name Hospitalized Total N Hospitalized Taotal M Risk ratio ratio StdEr Variance J
1 M 76001 3 965 4 482 1124 0117 0.538 0.358
2/ WAERT0 1 484 2 235 0.243 -1.416 1.222 1.434
3 WAEETT E 41 1 2m 2934 1.076 1.077 1.153
4 WANET07 2 17 1 3 1.053 0.057 1.183 1.330
b WATEB12/872 3 133 3 202 1.m5 0015 0.461 0212
B WA/15813/876/978 3 362 n 373 0.843 0171 0.443 0137
7| w1277 2 225 4 226 0.502 -0.683 0.861 0741
8
9
1n
Click File > Save As and save the file
@ Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Computational options Analyses Help
D New.. CIERE e R AT
= Open Ctrl+Q T amiflu Flacebo Placebo . Log rigk .
= . . ed Total N Hospitalized Total N Risk ratic ratio StdErr Variance !
Opening screen wizard
9 955 4 182 1124 0117 0.598 0.358
Jneor 1 404 2 23 0243 1416 1222 1.494
& Save Ctrl+§ 5 411 1 201 2934 1.076 1.077 1.159
2 17 1 El 1.059 0057 1.153 1.330
9 199 El 202 1.015 0015 0.481 n.212
& Print... trl+P | 362 1 373 0543 017 0.443 0197
B Print setup... 2 225 4 226 0502 -0.689 0.881 0.7
Exit
10
11
12
13
14
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Note that the file name is now in the header.

e [Save] will over-write the prior version of this file without warning
e [Save As...] will allow you to save the file with a new name

@ Comprehensive meta ana\»[s - [CA\Users\Biostat\Dropbox\Workshops Three-Day\Tamiflu\Tamiflu Hospitalized.cma)

Eile Edit Format View I“W
Run analyses + % [ ﬁn S 4 BB &l r—"'= L= H - =2+ \/D %¢ §¢ @
Sudprome | ol | Tami | Hossedned | Tamn | Poko | S| suEn | vaionce |
1 M 76001 4 965 4 482 1124 0117 0.598 0.358
2 WAEETD 1 434 2 235 0.243 -1.418 1.222 1.494
3 WwWA5E71 B 411 1 201 2934 1.076 1.077 1.159
4 WwA5707 2 17 1 | 1.053 0.057 1.153 1.330
5 wA5812/872 | 133 3 202 1.015 0.015 0.461 0.2z
B WA/155819/876/978 | 362 1 373 0.843 017 0.443 0137
T WAABZTT 2 225 4 226 0502 -0.689 0.861 0.7
g
9
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By convention we’ve put the treated group (Tamiflu) in the first two columns and the control (placebo)
in the second two columns. Also by convention, we’ve defined “Event” as the presence of the outcome
(Hospitalized).

When we follow these conventions, and the outcome is a bad event (as it is here) if the treated group
does better than the control, the risk ratio will be less than 1.

Therefore, in the present case, a risk ratio less than 1 indicates that Tamiflu was associated with a
decreased risk of hospitalization.

It’s always a good idea to check at least one study and make sure that we have the direction right. For
this purpose we’ll use the last study, where the risk ratio is relatively large, and the distinction between
groups should be clear.

@ Comprehensive meta analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Tamiflu\Tamiflu Hespitalized.cma]

File Edit Format View Insert Identify Tools Computational options Analyses Help
Run analyses &+ %= [ = H & & 12 &l r—"'= L= H b2+ D %¢ §¢ @
Study name HDESTa‘fI!lZJEd Ig{g:fh HDPSIE?E::?:ed E’[Igtc:‘;f Rizk ratio Lo[gtglosk StdEm Variance J N
1 M 76001 g 965 4 482 1124 0117 0.598 0.358
2| 'whABETD 1 484 2 235 0242 -1.418 1222 1.454
3 w5671 B 41 1 2 2934 1.076 1.077 1.159
4 w5707 2 17 1 | 1.053 0.057 1153 1.330
8 w1581 2/872 3 133 3 202 1.5 0.ms 0.461 0212
B wh15813/876/975 3 362 1Al 373 0843 0171 0.443 0137
7 WwWABZEF 2 225 4 226 0.502 -0.689 0.861 0.741
8
4

Both groups have approximately the same number of patients (about 225) but the number of
hospitalizations is higher in the Placebo group than in the Tamiflu group (4 vs. 2). The risk ratio is less
than 1 (0.502), which means that patients treated with Tamiflu were less likely to be hospitalized.

e To run the analysis, click [Run analysis]

analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Tamiflu\Tamiflu Hospitalized.cma]

File Edit Format Viel Insert Identify Tools Computational options Analyses Help
Runanases » % N | & & 2R E'-"'="ER w5 -4 2+ D
e e— Tarmniflu T amiflu Placebo Flacebao . Log risk .
Hospitalized Tatal M Hospitalized Tatal M Risk ratio ratio StdEn Variance ! N

1 M 76001 g 965 4 482 1124 0117 0.598 0.358
2| 'whABETD 1 484 2 235 0242 -1.418 1222 1.454
3 w5671 B 41 1 2 2934 1.076 1.077 1.159
4 w5707 2 17 1 | 1.053 0.057 1153 1.330
8 w1581 2/872 3 133 3 202 1.5 0.ms 0.461 0212
B wh15813/876/975 3 362 1Al 373 0843 0171 0.443 0137
7 WwWABZEF 2 225 4 226 0.502 -0.689 0.861 0.741
8
4
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This is the basic analysis screen

Initially, the program displays the fixed-effect analysis. This is indicated by the tab at the bottom and
the label in the plot.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
4+ Data entry 13 Next table :{» High resolution plot % Selectby ... | =+ Effect measure: Risk ratio - IE‘ I:‘ EE TT :1_-*'- E :E T @
Model Study name Statiztics for each study Riizk ratio and 95% Cl ‘weight [Fixed)
Rizk ratio | Lower limit | Upper limit | Z-4/alue palue 0. 010 1.00 10,00 100.00 Fielative weight
M FEO01 1124 0.348 363 0155 0.845 —_— 17.22
Wh1EE70 0.243 n.0z2z2 2.664 -1.158 0.247 41310
w1567 2934 0.356 24.209 1.000 0.n7 5320
WhE707 1.089 0110 10181 0.050 0.960 46310
w1582/ 1.015 0411 2.504 0.032 0.974 e 29.04
15819/ 0.843 0.354 20ma -0.385 0.700 — 31.35
16277 0502 0.093 2714 -0.800 0.424 232l
Fixed 0.919 0.565 1.494 -0.342 0.732 —H—

Four of the studies have risk ratios very close to 1.0, which means that the treatment was unrelated to
outcome. Two studies show an advantage for Tamiflu and one study shows an advantage for placebo,
but none of these is statistically significant.

The effects seem to be reasonably consistent. The confidence interval for every study overlaps the
mean.

The pooled effect is 0.919, which means that Tamiflu decreases the risk of being hospitalized by about
8%. However, the confidence interval is 0.565 to 1.494, and the p-value for a test of the null is 0.732.

© www.Meta-Analysis.com Tamiflu hospitalized — 15 —
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Click [Both models]

The program displays results for both the fixed-effect and the random-effects analysis.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
+ Data entry 173 Next table I High resolution piot | [gh Select by .. | =+ Effect measure: Risk ratio EIC|EETTIHE F| &2 @
Model Study name Statistics for each study Rigk ratio and 95% C1 Wweight [Fixed] Weight [Random]
Risk ratio | Lower limit | Upper limit | ZValue p¥alue 0.01 010 1.00 10.00 100.00 Relative weight Relative weight
M FEOOT 1124 0348 263 0195 0.845 e 17.22 172z
k] 0.243 n.nzz 2664 -1.158 0.247 4131 4131
w1867 259314 0.356 24.209 1.000 0317 53z 53z
WwE1ET07 1.059 0110 10181 0.050 0.960 1631 16311
w1582/ 1015 0.411 2504 n.o32 04974 o 29.04 I 29.04 N
wh15813/) 0.843 0.354 2010 -0.385 0.700 — 31.35 31.35
e 7 0502 0.032 2714 -0.800 0424 kel | kel |
Fired 0919 0565 1.454 0342 0732 —i—
Random 0519 0.565 1.454 -0.342 0.732 —

Under the fixed-effect model the pooled effect size is 0.919 with a confidence interval of 0.565 to 1.494.
Under the random-effects model the pooled effect size is 0.919 with a confidence interval of 0.565 to
1.494. While the two models yield identical results, the random-effects model is a better fit for the way
the studies were sampled, and therefore that is the model we will use in the analysis.

e The fixed-effect model would be appropriate if all the studies were virtual replicates of each
other, which may or may not be the case here. The may have patients varied in some ways.

e The random-effects model would be appropriate if the studies vary in ways that may impact the
effect size.

Under the circumstances the random-effects model will yield a more conservative estimate (the
standard error will be as large or larger as compared with the fixed-effect model).

© www.Meta-Analysis.com Tamiflu hospitalized — 16 —
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e Click Random on the tab at the bottom

The plot now displays the random-effects analysis alone.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
4+ Data entry 13 Next table :{» High resolution plot % Selectby ... | =+ Effect measure: Risk ratio - IE‘ |:| EE TT :1_-*'- E :E i @
Model Study name Statiztics for each study Rizk ratio and 95% C| ‘weight [Fandom]
Rizk ratio | Lower limit | Upper imit | Z-4alue palue 0. 010 1.00 10,00 100.00 Fielative weight
M FEO01 1124 0.348 36N 0195 0.845 —_—— 17.22
Wh1EE70 0.243 n.0z2z2 2.664 -1.158 0.247 41310
w1567 2.934 0.356 24.209 1.000 0317 5320
w5707 1.059 0110 10151 0.050 0.960 4630
W52/ 1.015 0411 2.504 0032 0.974 e 29.04
WA 15819/ 0.843 0.354 200 -0.385 0.700 — 31.35 I
16277 0.502 0.093 2714 -0.800 0.424 jhery |
R andom 0.919 0.565 1.494 -0.342 0.732 —H—

A quick view of the plot suggests the following

=  Most of the studies show no real advantage for either group

= The observed effects are pretty consistent

= The summary effect is 0.919 with a Cl of 0.565 to 1.494

= The summary effect has a Z-value -0.342 a p-value of < 0.732. Thus we cannot reject the null
hypotheses that the true mean risk ratio is 1.0.
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The statistics at the left duplicate those we saw on the prior screen.
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The summary effect is 0.919 with a Cl of 0.565 to 1.494. The test of the null (that the true risk
ratio is 1.0) yields a Z-value of —0.342 and a corresponding p-value of 0.732.

The statistics at the upper right relate to the dispersion of effect sizes across studies. The Q-
value is 3.054 with df=6 and p=0.802. Q reflects the distance of each study from the mean
effect (weighted, squared, and summed over all studies). Q is always computed using FE
weights (which is the reason it is displayed on the “Fixed” row, but applies to both FE and RE
analyses.

If all studies actually shared the same true effect size, the expected value of Q would be equal to
df (which is 6). Here, Q is less than this value, and so there is no evidence of variance in true
effects.

I? is the proportion of the observed variance that reflects differences in true effects rather than
sampling error. Since the variance in true effects is zero, > must be zero.

T2 is the estimate of the between-study variance in true effects. Tis the estimate of the
between-study standard deviation in true effects. Since the variance in true effects is zero, both
of these values must be zero. These value are both in log units.

Click [Next table] to return to this screen
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Summary
Synopsis

This analysis includes seven studies where patients were randomized to receive either Tamiflu or
placebo. Outcome was the proportion of patients hospitalized in each group. The effect size is the risk
ratio.

Does Tamiflu affect the risk of hospitalization?

The mean risk ratio is 0.919, which means that being assigned to a Tamiflu rather than a placebo
resulted in an 8% lower risk of being hospitalized. The 95% confidence interval for the risk ratio is 0.565
to 1.494. The Z-value for a test of the null is -0.342, with a corresponding p-value of 0.732.

These studies were sampled from a universe of possible studies defined by certain inclusion/exclusion
rules as outlined in the full paper. The confidence interval for the risk ratio is 0.565 to 1.494, which tell
us that the mean risk ratio in the universe of studies could fall anywhere in this range. This range
includes a risk ratio of 1.0, which tells us that the mean risk ratio could be 1.0.

Similarly, the Z-value for testing the null hypothesis (that the mean risk ratio is 1.0) is -0.342, with a
corresponding p-value of 0.732. We cannot reject the null that the risk of hospitalization is the same in
both groups.

Does the effect size vary across studies?

The observed effect size varies somewhat from study to study, but a certain amount of variation is
expected due to sampling error. We need to determine if the observed variation falls within the range
that can be attributed to sampling error (in which case there is no evidence of variation in true effects),
or if it exceeds that range.

The Q-statistic provides a test of the null hypothesis that all studies in the analysis share a common
effect size. If all studies shared the same effect size, the expected value of Q would be equal to the
degrees of freedom (the number of studies minus 1).

The Q-value is 3.054 with 6 degrees of freedom. Thus, the observed dispersion is actually less than we
would expect by chance. It follows that there is no evidence that the true effect size varies from study

to study.

The /? statistic tells us what proportion of the observed variance reflects differences in true effect sizes
rather than sampling error. Since the variance in true effect sizes is zero, I must be zero.

T2 is the variance of true effect sizes (in log units). Here, T?is zero. Tis the standard deviation of true
effects (in log units). Here, T is zero.
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